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Using the Surface Water Data Viewer (SWDV) 
 
Introduction 
 
The Surface Water Data Viewer database (SWDV) displays data from 
the State’s monitoring and assessment databases that can be used for 
resource management and watershed planning at local, regional, or State 
levels such as: 

o Waterbody physical characteristics 
o Water quality assessments and monitoring sites 
o Aquatic invasive species   
o Wetlands, plants, and habitat 
o Grant locations 
o Fisheries management waters 

 
The SWDV contains a variety of mapping tools for users to create 
customized maps of selected cultural, resource, administrative, land, and 
environmental features.  Digital air photo or topographic map layers can 
also be added.  This user guide explains how to use the features of the 
SWDV database for watershed planning activities.  
 
The SWDV uses the 1991 datum adjustment to NAD 1983.  It is the 
DNR’s standard datum, and the Wisconsin Transverse Mercator (WTM) 
projection (which the viewer uses) is based off of it.  “Datum” refers to a 
geometric model called a spheroid that approximates the shape of the 
earth.  A sphere is perfectly round, but a spheroid has one axis that is 
longer than another.   
 
The SWDV uses the ArcIMS (Internet Map Server).  WDNR uses 
Moximedia’s Internet Mapping Framework as its viewer.  IMF is a java-
based “thin client” that can run any number of different mapping sites, 
with a combination of shared program files and unique configuration 
files. 
 
See the Appendixes for descriptions of the basic tab functions, basic tool 
buttons, advanced tool buttons, and map layers of the SWDV. 
 
For questions or comments on the SWDV, please email:  Matt Rehwald 
in the Bureau of Watershed Management:  
Matt.Rehwald@wisconsin.gov 
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Access the Surface Water Data Viewer 
 
Step 1:  Type in this URL:  http://dnr.wi.gov/ .  Click on the “Where You Live” link. 
 
 

 
Step 2:  Click on the “Surface Water Data Viewer” link. 
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Navigate to a Location/Attribute 
• “Zoom to” a Place Button 

Click on the “Zoom To” button.  A drop-down menu will appear on the left.  
Click on the category for your search. You can zoom to a variety of watershed 
geographical locations or to a specific waterbody by its name or WBIC number.  
NOTE: If you want to zoom to a location in an unincorporated area, choose the 
“Civil Town” option.  Use the “Zoom In” and “Zoom Out” buttons if needed to 
refine your search location.   
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

•  “Find Location” Tab 
Click on the “Find Location” tab and select a search category from the “Find 
Location” list in the left-hand column.  Type in the additional information 
requested to refine your search. 
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•   “Select By Attribute” Search 
Click on the “Select” tab.  Choose one of options in the “Selection Menu.”   
 

 
 

 
 The “Select Attribute” drop-down 

menu allows you to select information 
according to the data layer.  Type in 
the additional information requested 
and then click on the “Submit” button. 
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View Map Layers 
 
Click on the “Layers” tab to display the layers of information you can add to a map.  
Click on a folder to open the map layer options.  Check a box to display a map layer 
of information.  NOTE:  See Appendix C for a description of the “Map Layer” 
datasets. 

 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
View Dataset Information 
 
Click on the “Map Layer” dataset in blue type to read information on the dataset that 
appears in a pop-up window.  Click on links to web pages with further information. 
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Display Legend 
 

Click on the “Legend” tab to display the map legend.   
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
Add Imagery and Basemap Layers 
 
Open additional folders to select other “layers” of information you wish to add to 
your map.  Scroll to the end of the “Map Layers” column to the “Imagery & 
Basemaps” folder to add topographic or air photo layers if desired.   
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Identify Results 
 
Click on the “Identify” button and then click on a location on your map with the 
layer(s) you have selected.  In this example, grant lake locations are highlighted. 
Information regarding that map layer location displays in the left-hand column. Click 
on the “More Detail” link in blue to find additional information related to the grant. 
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Download Watershed Information for a County 
 
Use the “Zoom To” feature and select the desired County from the drop-down arrow 
list.  Check the watershed map layer you wish to download.  ( In this example, 
Chippewa County was selected with 24K Watersheds.)   
 

 
 
Click on the “Select” tab (see instructions on page 5) and choose the “Select by 
Attribute” option.  Select the “County Boundaries” option.  Select “Name” for field 
and type in the county name in “Attribute Value”.  Click on the “Submit” button. 
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The County line is highlighted in yellow.  Click on the “Select” tab again and then 
click on the “Select by Layer” option.  Choose one of the layer options. (In the 
example below the 24K Watersheds options was selected.)  Click on the “OK” 
button. 

 
Click on one of the download options in the 
“Selection Set” column.  In this example, the 
“Extract to Excel” file was selected.  Select 
how you wish to open the document in the next 
window.  The example below shows the 
information on 24K watersheds in Chippewa 
County opened in an excel document.  
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Create a Shape File 
 
A shape file is a spatial data file.  You can extract certain data layers to a shape file to 
use in your own GIS-type software.  Click on the “Advanced Tools” button.  Then 
click on the “Extract Layer to Shape File” tool to the left of the “Basic Tools” 
button.  Select one of the data layers from the “Layers Name” drop-down arrow list. 
Click on the “Ok” button. 

 
 
Click on the “download the zip file” link to copy the data to your files. 
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Make Maps  
 
You can add your own labels or text to a map once you’re at your final map location 
with the map layers turned on and desired scale. Click on the “Advanced Tools” 
button.  Note: Once you click on this button again, it will revert back to the “Basic 
Tools” button label. 

•  Label Map Point with Latitude/Longitude Coordinates  
 

Adjust the scale of your map to 1:5000 for more accurate latitude/longitude 
coordinates.  Click the “pencil” icon with the “dot”.  Click on the map where you 
want to put a “dot” (a star) and text. A box on the left will appear where you can 
choose the color of the star and enter some text. Click on the “Label with map 
coordinate” link to add the longitude and latitude.  Click on the “Submit” button. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
   Adjust Scale here 
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•  Add a Text Box 
 

Click on the “pencil A” icon to add a label with text.  A box on the left will 
appear where you can add map text.  Enter your text and then click on the “OK” 
button. 

 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

• View/Edit Your Map 
View the markup features you added to the map. If your map is not correct, you 
can edit it. Click on the “eraser” icon to erase your text.     



 14

• Print/Save a Map  
 
Click the “printer” icon or the “Print” tab to create a PDF Map. Use the drop-
down arrows to select the desired template and scale.  Make sure the other 
information in the text boxes on the left-hand side of the screen is correct and 
click on the “OK” button. 
 
Click on the “open map” link in the “create a PDF Map” screen. Click on the 
“printer” icon to print your PDF map. Click on the “disk” icon to save the map 
on your computer or disk. 
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Appendix A:  Basic Tabs, Basic Tools  
 

• Basic Tabs 
 

 
  

  
  Surface Water Data Viewer (SWDV) 
  

      
   
 

  

You can check and "uncheck" any layer you want.  The "Layers" represent 
different topics, such as dams, zebra mussel infestations and impaired waters.  
Layers also include background images like air photos and topographic maps.  
You can also click the label icon to turn on and off text labels on the map. 

   
 Some especially handy layers: 
  Monitoring Stations (Under Resource Management Data) 
  Eurasian water-milfoil infestations (Under Resource Management Data) 
  Zebra mussel infestations (Under Resource Management Data) 
  Digital air photos (under Imagery & Basemaps) 
  Digital topographic maps (under Imagery & Basemaps) 
      
   
 

  

The Legend tab will show you what the colors & symbols mean on the map, 
based on the layers currently checked under the Layer tab.   
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 Find Location accomplishes the same thing as the Zoom To button.  You can 
specify where you want to go (such as a City/Village) and the map will zoom 
there.  The Find Location tab also lets you zoom in to a Latitude and Longitude.  
You can also add your own personal bookmarks. 

      
   
 

  

Help provides some basic tips on using the buttons described in these 
handouts. 

  
   
 

  

The Print tab is very useful.  Using this tab, you can generate a .pdf file of the 
map and legend.  This can be incredibly useful for handouts at a meeting, or for 
use in a presentation.  Also, if you want an image of the map you can copy and 
paste it into a document.  Just hold your mouse over the map itself and right 
click.  Then choose Copy.  Then, in your Word document or PowerPoint 
document, go to Edit, then Paste. 

      
 

• Basic Tool buttons 
 
 

  
   

 
   
  
  Surface Water Data Viewer  

        
    
 Changes the extent of the map to show the entire state of Wisconsin.  
       
    

The Zoom In button allows you to window into a particular area of interest to see more 
detail. You can do this in two ways. Using the mouse, "left click" on the Zoom In button and 
then: 

 
  

 

* "left click" a point on the map you wish to be the center of your selected area (one 
"click" zooms in approximately 2X, you can do this as many times as you want until you 
have the right extent defined), or: 
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* define a window by "left clicking" on a point and, keeping the mouse button depressed, 
"pull" the rectangle being formed until it covers the area of interest and release the 
mouse button. 

  

 

 * If you have zoomed in too far, use the Zoom Out button to "back out" (approximately 
2X each "click") until the appropriate area has been defined. 

 

        
    
 Clicking the map with the Zoom Out tool active causes the map to "back out" so you can 

see approximately 2 times more each "click". The map will be centered at the point clicked. 

 
        
    

Use this option to quickly zoom to a specific area of interest, such as a county, city, or 
Public Land Survey System Township/Range/Section.  

 

  
        

    
 The Move tool (also referred to as "pan") is used to move the area shown in the map 

window to the left, right, up or down. This is accomplished by left clicking the mouse cursor 
on the Move button to activate, moving the mouse cursor over the approximate center of 
the map and then, keeping the left button depressed, dragging the map window until the 
adjusted area of interest is displayed. Release the mouse button. 

 
        
    
 The “drill down” identify tool displays information about each visible layer at the map 

position clicked. To use, simply click the map and view the results in this window. 
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Appendix B:  Advanced SWDV Tools 
 

New Advanced Viewer Tools 
 

Click the Advanced Tools button to access these.   

The advanced tools toolbar will display. 
 

 Full Extent: 
Returns you to the initial statewide view. 
 

  Zoom In: 
Either click once on the map, or click and drag the mouse (move the mouse with 
the left button pressed) to draw a box around the area you want to zoom into. 
 

 Zoom Out: 
Click once on the map to zoom back out.   
 

 Pan: 
Click and drag the mouse on the map to move in any 
direction.  The map will refresh when you release the 
mouse button. 
 

 Zoom Last: 
Returns the map to where you were before you last 
panned or zoomed the map. 
 

 Index Map (New): 
Shows you where the main map is in relation to the 
entire state.  Click on the index map to move the main 
map to a different location. 
 

 Print: 
Gives you a menu of options for creating a PDF 
version of the current map.  
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 E-Mail: 
Gives you a menu of options for sending the current map to someone as an 
email. 
 
 

 Single Layer Identify (New): 
Allows you to identify features in a particular layer.  Click on 
this tool, then click on the “i” icon next to the checkbox for a 
particular layer in the list of layers, then click on a feature of 
interest on the map.  
 

 Multi-layer Identify: 
Allows you to identify all of the visible features where you click on the map.   
 

 Map Tips (New): 
Allows you to identify a feature on the map (without clicking).  Hover the mouse 
over a feature for about 1 second, and an attribute will appear automatically.  As 
a demonstration, Map Tips are available for the following layers: 
 

• SWIMS Monitoring Station names 
• GNIS Point names (Internal Viewer only) 
• Dam names (Internal Viewer Dam Theme) 
• Flood Insurance Study file names (Internal Viewer Floodplain Theme) 

 
 

 
 
 
 
 
 

 Select Features: 
Allows you to select individual features on the map.  Click on 
this tool, then click on the “arrow and circle” icon next to the 
checkbox for a particular layer in the list of layers, then click 
on a feature of interest on the map to select it.   
 
 

 Select by Radius (New): 
Similar to the above.  Allows you to select features by clicking on the map, then 
specifying the radius of a circle.  Features in your layer of interest that fall at least 
partially within the circle will be highlighted, and the circle will be displayed on the 
map. 
 

 Clear Selections: 
Clears any selected features on the map. 
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 Measure Length: 
Calculates the distances and bearings between points you click on the map, and 
keeps a running total of all the distances. 
 
 

 Measure Area:   
Allows you to calculate the area of a polygon you digitize on the map. 
 

 Point Markup: 
Allows you to add a star where you click on the map.  You can label and/or add a 
coordinate position to the point, as well. 
 

 Line Markup (New): 
Allows you to digitize a line on the map by clicking several connected points. 
 

Rectangle 
Markup: 
Allows you to 
digitize a 
rectangle on 
the map by 
clicking and 
dragging the 
mouse. 
 

 Polygon 
Markup (New): 
Allows you to 
digitize a 
polygon on the 
map by clicking 
several 
connected 
points.  
 

 Text 
Markup: 
Allows you to add text where you click on the map. 
 

 Add a Label (New): 
Allows you to click on a feature on the map, and label it with any available 
attribute field value. 
 

 Create Map Grid (New): 
Creates an atlas-style map, allowing you to reference map features by row and 
column. 
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 Erase Selected Markup (New): 
Allows you to erase individual markup elements on the map by clicking on them. 
 

 Erase All Markup:  Erases all markup elements. 
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Appendix C:  Data Set Descriptions 
 
The Surface Water Data Viewer is the Wisconsin Water Program’s vehicle for sharing GIS 
and related data with others. These datasets have been reviewed and documented to provide 
you with the best possible information we have available. Please note the significant updates 
and new layers now available.  
 
For questions or comments, please email: Matt Rehwald in the Bureau of Watershed 
Management (matt.rehwald@wisconsin.gov). 
 

New Folders & Datasets  
• Fisheries Management Waters  

o Muskellunge Waters (new!) 
o Sturgeon Waters (new!) 
o Smallmouth Bass Waters (new!) 
o Walleye Waters (new!) 
o Trout Streams (moved to this folder) 

• Monitoring & Assessments (Formerly “Resource 
Management Data”) 

• Invasive Species  
o Eurasian Water-Milfoil (moved to this folder) 
o Zebra Mussels (moved to this folder) 
o Reed Canary Grass Infestations (new!) 

• Wetlands, Plants & Habitat 
o Wisconsin Wetland Inventory (new!) 
o Critical Habitat Areas (new!) 
o Upland Protection Areas (new!) 
o Wild Rice Waters (new!) 
o High Quality Wetland Waters (new!) 
o Wetland Restorations (new!) 

• Permits & Related Data 
o Designated Waters (moved to this folder) 
o Land spreading Pilot Project (moved to this 

folder) 
o Waterway & Wetland Alterations (moved to this 

folder) 
o Erosion Control General Permit Availability 

(new!) 
o Surface Water Outfalls (moved to this folder) 

• Grant Locations 
o Non-point source (NPS) Grants (new!) 
o Lake Grants (new!) 
o River Grants (new!) 

• Recreation & Trails 
o Boating Ordinances (new!) 

• Forests & Landcover 
o Omernik Ecoregions (new!) 

• Imagery & Basemaps 
o 2005 NAIP Color Air Photos (new!) 
o Color Photos-24K Topo Merge (new!) 

 
 
Please note that not all datasets are complete. Blue hyperlinks take 
you to data descriptions that provide information on completeness and 
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disclaimers.  

 

New Datasets of Special Note:  

2005 NAIP Color Air Photos  

The 2005 NAIP Color Air Photos (Leaf-on) are 
now available, in addition to the previously 
available DOPs. A “merge” of the color air photos 
and USGS 1:24000 topo maps is also available.  

 

 

 

 

Erosion Control General Permit Availability  

This layer is used to determine which types of general permits are available for a waterway 
alteration project. 
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*Wisconsin Wetland 
Inventory  

Wetlands for many counties are 
now available on the viewer.  Be 
sure to read the disclaimer for 
details and limitations of the 
data. 

 

 

 

 

 

 

 

 

 



 25

Grant Locations, Descriptions and Final Reports Online!  

You can now access the state’s Rivers, Lakes and TRM grant data online! 
Simply turn “on” the grant layer you wish to view, then go to your area of 
interest. Click “identify” for more information.  

 

 

 

If a final report or other 
document is available 
electronically for the grant of 
interest, it will be 
“downloadable” from the “more 
detail” area. The example above 
shows that the final report for 
the Barron County Lakes grant 
is available in a PDF format. 
Below is the report that you can 
read once you click on the 
hyperlink: 

 

 

 

 

 

 

 

 

 

 

 

 

 


